Colour Management and Adobe Photoshop 6

By lan Lyons ©

When Photoshop 6 was announced to the world in late August 2000 much was made of
features such as the improved interface, increased vector support, enhanced layer effects, etc.
However, little was mentioned of colour management. Y et, the manner in which Photoshop
now deals with colour within documents/images has been significantly altered, for the better.

This article will explain the main changes and make suggestions as to how the new
Photoshop 6-colour management system should be configured. The reader shouldn't consider
my preferences as "the best”, just a base point from which to begin the process. However,
careful reading should give some clues as to why | made certain choices.

Colour Management Primer

Typicaly, each Device will reproduce colour differently, so that the colour we see at one
stage of the imaging process will rarely if ever match the colour seen at the next stage. In
other words, colour is Device-dependent. The purpose of a Colour Management System
(CMYS) isto maintain a consistent “appearance” of colour on different devices (i.e. scanners,
monitors, printers, etc.) throughout our system. A colour-managed system will comprise three
basic components, namely: -

* A device-independent colour space. Usually referred to as the Working Space or
Reference Colour Space.

* [CC/ColorSync profiles for each device (printer, scanner, monitor, digital camera, etc.)
that describes the characteristics of the device.

* A Colour Matching Module (CMM) that will interpret the information contained within
device profiles and carries out their instructions on what way the colour gamut of each
device should be treated.

A typical “Colour-managed Workflow” will involve the image data being passed along the
chain - from scanner - to - computer - to - monitor - and printer (see the diagram below).
To minimise the colour discrepancies that result primarily from the widely differing colour
spaces of each device we must give the CMM information in the form of device “Profiles’
that accurately describe the colour gamut of each device.

Most devices are supplied with generic or “Canned” profiles that describe them pretty well,
but for truly accurate colour matching you should seriously consider either getting
“Customised” profiles for each device done professionally or buying your own profiling
software.
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It is aso worth pointing out that whilst most low cost, consumer based film and flatbed
scanner applications are ICC/ColorSync aware they tend to impose sSRGB as the “ Source’
colour space. This colour space is inappropriate for high quality image editing when either
print or film output is required. Some manufacturers e.g. Nikon, Polaroid and MicroTek
alow us to scan and save our images in any, “Destination” colour space we choose.
Unfortunately others make similar claims but in reality the “Destination” colour space is
generaly always “sRGB”. Furthermore, the image is rarely if ever delivered into Photoshop
with an embedded profile (i.e. “tagged”). The new Assign Profile command introduced with
Photoshop 6 will help overcome some of the problems this issue causes.

In with the NEW

Leaving aside (for the moment) the interface changes associated with configuring the
Photoshop colour management system we find that the biggest and most far reaching change
is;, support for "document/image specific" colour. In Photoshop 5, it is the Working Space
that defines how all the open images are displayed. Therefore, in order that we can preview
the image accurately it must be in the same Working Space as is defined in the Photoshop 5
"RGB Setup" dialog. However, with Photoshop 6, the Working Space defined in Color
Settings only really has a bearing on three types of image, viz.: -

* new images/documents;

* existing images/documents without an embedded profile; and

» images/documents with no embedded ICC/ColorSync profile (i.e. "untagged
images/documents” typically form digital cameras and low end scanners, etc.).

"Image specific" colour means that it's the profile embedded within an image that determines
how the image will be displayed and not the Photoshop Working Space. With Photoshop 6
we can have multiple images, each in its own unique Work Space open at the same time and
each will be displayed accurately (of course this assumes awell calibrated monitor).

Another important change that users will quickly find is the absence of the "Display Using

Monitor Compensation” checkbox. It's not that Adobe has removed the feature from
Photoshop, but that they have configured it so that the users can't easily turn it off.
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Also note that a few new commands have been introduced, namely "Assign Profile",
"Convert to Profile" and "Proof Setup”. The first two are accessed from the "Image > Mode"
menu, and the last from the "View Menu", | will discuss them in detail |ater.

| could go on at length waffling about each an every feature change, but | think it better that |
leave such explanations to those who really understand Photoshop 6 colour management,
namely Andrew Rodney and Chris Murphy. Their material can be read at
http://www.diqgitaldog.net and http://www.colorremedies.com respectively.

Please note that except for the minor interface differences; Photoshop 6 for the Mac and PC
share a virtually identical set of features. Therefore the Mac OS based screen grabs that
follow should be very useful to PC users. Of course there will always be those that ook
totally different, but so far asthis article is concerned they are confined to printing and saving
your images.

Part 1 - Monitor Calibration and Characterisation

On opening Photoshop 5 for the very first time users were provided with the "configure the
colour management system" wizard, but such luxuries are not present in Photoshop 6. This
means that the new user is already at a distinct disadvantage.

Nevertheless, we can make a start on our own by first calibrating and characterising the
monitor, which can be achieved by using the now familiar Adobe Gamma utility.

Adobe Gamma is a "Control Panel" utility that can be accessed from the "Apple Menu >
Control Panels' on the Mac and "My Computer > Control Panel" on the PC. Before running
Adobe Gamma,

* itisbest that your monitor has been switched on for at least 30 minutes;
» work in subdued lighting when calibrating a monitor using Adobe Gamma; and

» set the white point of your monitor. Typically, it will be set for 9300°K, which is
far too blue for our purposes. This is a hardware adjustment, and how you do it
depends on the monitor you are using. Most monitors have a control panel. If
youre unsure how to set the white point on your monitor, consult the
documentation that came with it.

Another good tip is to set your "Desktop Colour" to grey. Mac users can do this via the
"Apple Menu > Control Panels' and then choosing "Appearance". Windows users should
choose "Start > Settings > Control Panel" and then "Display”.

Using Adobe Gammavis pretty straight forward, but I've included a few more tips along with
the screen grabs.
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When the Adobe Gamma utility isfirst
opened you will be asked to make a choice
between the "Assistant" and the "Control
Panel” method. It's probably easier to use

the "Step by Step Assistant” method.

= s Adobe il =5————————

This control panel will allow you to calibrate vour
monitor and create an ICC profile for it.

Which version would you like to use?

@ Step By Step (Assistant)
_» Control Panel

This ICC Profile will be compatible with

!‘}h‘el@

Adobe Gamma Assistant

Give the profile a unique descriptive name that
will appear in application pop-up menus.

Description: | Diamond Plus 91 {29/10/00)

This profile will serve as a starting point for the
calibration of your monitor. Ifyou wish to start
with a different profile, click on Load.

Back

[ Cancel ]

=

Next

From here on in make sure, you follow the
instructions carefully.

Set your monitor contrast control to
maximum and then adjust the brightness
control until the innermost grey squareis
only just visible against the black surround.

Squinting your eyes helps with this process,
as does keeping the room lighting at alow
level or off.

ColorSync™ on Macintosh and ICM 2.0 0n
Windows.

[ cancel | | Back | [[ Next |

Choose your monitor profile or pick one
that’s close. If in doubt choose the Adobe
default monitor profile or even sRGB, it
really makes little difference since all we are
doing is defining the start point.

Before progressing to the next step, be sureto
give the profile a unique description and

include the date.

Adobe Gamma Assistant ="———————

m@

The first step in calibrating your monitoris to
ddjust the brightness and contrast controls to their
optimal settings.

(B First, set the contrast control to its highest
setting.

% Then, adjust the brightness
control to make the center
box as dark as possible
{but not black) while keeping
the frame a bright white.

[ cancel | [ Back ]“ Next ||
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Adobe Gamma Assistant

The red, green, and blue phosphors in a monitor
can vary from one manufacturer to the next.
EBU/ITU

SMPTE-C (CCIR 601-1)

Phosphors: |/ Custom... |

Your curren|  HpTV (CCIR 709) that your
monitor us NTSC (1953) . Ifyou know
this to be in P22-EBU ifferent setting.

L-'n\h!'a [ cancel | [ Back | [ Next

J

Begin by keeping the "View Single Gamma"

If you're using a manufacturer supplied profile for
your specific make and model of monitor thenin
all probability the Phosphors will be listed as
"Custom”. If thisis the case, |leave well aone.

If you don't have, a monitor profile choose either
Trinitron or P22-EBU.

| keep getting asked -"how do | decide whichis
appropriate for my monitor?' In truth, it matters
little, but for those who are determined to make
the perfect choice; you can tell a Trinitron
monitor by simply looking at the display area. A
Trinitron type monitor will have two faint lines
running across the display area approximately 1/4
from the top and 1/4 from the bottom. If your
monitor has these lines choose Trinitron,
otherwise choose P22-EBU.

Adobe Gamma Assistant

selected for now. Although keep in mind that

this option "ONLY" alows you to adjust the
relative brightness of the monitor, not
neutralise any colour imbalances

Depending upon your computer type choose
either the "Windows Default" or "Mac
Default" gamma. In reality, this choiceis not
so important and you can choose either in the

The gamma setting of your monitor defines how
bright your midtones are. Establish the current
gamma by adjusting the slider until the center box
fades into the patterned frame.

b4 View Single Gamma Only

O

knowledge that Photoshop will make the
appropriate corrections when necessary.

Adjust the dlider until the inner grey square [,j‘f

DS —
Now choose the desired gamma.
Gamma: [Windows Default i]

[ Cancel ][ Back ]” Next ]I

blends with the outer frame, squinting slightly
can help. Finaly, deselect the "View Single
Gamma" checkbox.

Adobe Gamma Assistant

The gamma setting of your monitor defines how
bright your midtones are. Establish the current
gamma by adjusting the slider until the center box
fades into the patterned frame.

[ View Single Gamma Only

Now choose the desired gamma.

Gamma: [Windnws Default ¢j

[a}h‘f [ Cancel ][ Back ] |[ Next

J

This step is where we neutralise the colour
imbalances inherent in our monitor. Adjust
each of the didersin turn so asto blend the
inner square with its coloured surround. Again
squinting isagreat help.

Green is usually the most difficult to get right,
but persevere. The closer you get to a perfect
match at this point the more accurate your

final profile will be.
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Choosing the "White Point" for your monitor is
pretty much aformality these days. Even the die-
hards are in agreement that 6500°K is probably the
best option on most systems.

Choosing 6500°K provides the cleanest and
brightest white point and closely matches daylight.
If you fedl confident, you could select the
"Measure" option, but be prepared for a struggle.

Y ou can choose 5000°K, but this usually produces
adightly dimmer and more yellow white point.

Adobe Gamma Assistant

Adobe Gamma Assistant

The white point of your monitor determines whether
you are using a warm or cool white.

The hardware white point of your monitor is shown
below. Ifyou know this to be incorrect, choose a
different setting or click on Measure to visually
estimate it.

Hardware White Point: [ 6500°K (daylight) =]
AR
M-:m [ cancel | [ Back | [ Next ||

your monitor's hardware setting. The current

choose a new value.

adjusted white pointis shown below. Ifdesired,

Adjusted White Point: | Same as Hardware

2

You can choose to work at a different white point than General |y, itls better to Ieave the AdJ usted White

Point setting at "Same as Hardware".

Nevertheless, this option, when available, is used to
choose aworking white point for monitor display if
that differs from the hardware white point set in the
last step. For example, if your hardware white point
is 6500°K, but you want to edit an image at 5000°K
because that most closely represents the
environment in which it will normally be viewed,
you can set your Adjusted White Point to 50000 K,

AN [ cancel | [ Back | |

Mext

]  and Adobe Gammawill change the monitor display

That'sit, if all has gone well you will have
adjusted the brightness, contrast and colour
settings of your monitor to the optimum values.

Make a quick check using the "Before" and
"After" radio button. If you're happy that the
screen display now looks more neutral than
before press the "Finish" button and "Save" the
profile. Once saved the profile will be available
for use by the OS and Photoshop.

accordingly: However, choosing this approach will
all cause the graphics card colour LUT to be
adjusted quite severely, and depending upon the
graphics card the screen can look quite ugly on
some systems. As indicated above | recommend
that you choose "Same as Hardware" and thus
avoid this problem.
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There are a number of third party aternatives to Adobe Gamma, which can be purchased
from companies such as Color Vision, Monaco Systems or Praxisoft. The advantage of
Adobe Gamma is that it's free, whereas the third party products can cost nearly as much as
Photoshop. However, since they use "hardware” and not the "eyeball” for the measurements
we are assured of much more accurate calibration.

The above companies can be contacted by following the URL's listed below: -
Color Vision - http://www.colorcal.com

Monaco Systems - http://www.monacosys.com
Praxisoft - http://www.praxisoft.com

Part 2 - Photoshop 6 Color Settings

Now begins the process of configuring Photoshop for how we want it to handle colour in our
documents. This is achieved through the new "Color Settings' dialog found under the "Edit"
menul.

The new "Color Settings" dialog is the control room for the Photoshop 6 colour management
system, and like al control rooms it's complicated. The default setting is "Web Graphics
Default”, but this is certainly not the best. The sooner we get things moulded into our own
preferred configuration the sooner we can begin working with Photoshop 6 in earnest.

I will work my way through each section of the "Color Settings' dialog in turn. Note the
"Description” box at the bottom of the dialog, as the mouse is moved across the various pop-
up menus, etc. you should see a short but informative explanation of what each menu does.
Also note the checkbox labelled "Advanced Mode", it's probably best that you select it now.
At least that way you will see everything that the "Color Settings' has to offer, even if some
are only applicable to the most advanced of Photoshop users.
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The first section is labelled "Settings'; this is ssmply a pop-up menu with a list of pre-set
Photoshop settings, plus any that you may have saved. Y ou need not worry too much about
this section just yet.

Working Spaces

The next section is labelled "Working Spaces’, and as | discussed earlier it will determine the
Working Space of certain images, namely the 3 types | mentioned above.

There are four types of Working Space in Photoshop, RGB, CMYK, Grey and Spot. For the
purposes of this exercise | will concentrate mainly on the RGB Working Space, since the
other three are of no real importance if you're printing colour images to a consumer class
inkjet printer from Epson/Canon/HP. If you're really interested in the others read the material
by Andrew Rodney and Chris Murphy that | mentioned before.

Page No 8 of 29



RGB - Working Space

Clicking the RGB pop-up menu with the mouse will produce a list of options similar to that
shown below. | chose "Adobe RGB (1998)" because it's the Working Space | settled on when
using Photoshop 5. Notice that Adobe RGB (1998) appears within a group of four Working
Spaces, each of which is device-independent, and in common use with a wide range of
Photoshop users. Typicaly "sRGB" will be confined to those users solely interested in web
design, "ColorMatch" is afavoured choice of many Mac users and "AppleRGB" is apparently
for Mac web design.

Notice that just above the four common Working Spaces we have "Monitor RGB" (green
spot in the screen grab), and in the case of Mac systems "ColorSync RGB". "Monitor RGB"
is simply the Working Space of your monitor as created by the Adobe Gamma utility (or a 3
party software/hardware combination).

Unlike version 5.x Photoshop 6 no longer shows in any obvious way, which monitor profile
is being used. However, quick check for "Monitor RGB" in the RGB Working Space pop-up
should put your mind at rest. It is possible to select your monitor space as the Photoshop
Working Space, but not really a good idea. "ColorSync RGB" is ONLY available to Mac
users and will reflect the settings chosen as part of the ColorSync 3.x setup.

The actual list of options available for selection as Working Spaces differs depending on
whether you activated Advanced Mode, or not. If you chose to activate Advanced Mode then
thelist of available RGB profileswill be quite extensive.

If you had previously been using another Working Space such as "BruceRGB" then it should
also appear as one of the options in this extended list. If it doesn't then you can create the
Working Space yourself by choosing "Custom” (yellow spot in the screen grab). The dialog
below appears and you simply type in the data as shown for the Primaries etc., remember to
give this new Working Space a name and click "OK".
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CMYK - Working Space

Making your choice of CMYK Working Space isn't that different to RGB except of the list of
available colour profiles is rather different. Again having "Advanced Mode" activated gives
us amore extensive list.

As mentioned above, the choice you make is irrelevant if using a consumer class inkjet, they
don't like CMYK, PERIOD! Inmy case | just picked US. Web Coated, but notice we can also
pick the old Photoshop 4 or 5 default CMYK options, the ColorSync settings (Mac only), or
even customise our own settings as shown below.

Page No 10 of 29



Example - Customised CMYK

Remember the above screen grab is an example of a customised setup, don't even consider
trying to configure your setup to match it.

Greyscale - Working Space

The Greyscale Working Space has probably undergone the biggest change from Photoshop 5
days. We now have access to two gamma settings, a series of five pre-set dot gain curves, the
ColorSync "Grey Work Space" (Mac only) and the ability to customise the dot gain to our
own requirements. This latter option is of particular significance to users of Jon Cones
Piezography Black and White printing system (to be discussed in a separate essay). The
screen grabs below show the various options and atypical customised "Dot Gain" curve.

Please note that if you choose to use a "Custom Gamma' or "Dot Gain" this will be the
Working Space listed in the Grey Working Space pop-up menu.
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Example - Customised Dot Gain Curve

One very important point, and one not to be missed regarding Greyscale, it is no longer tied
to the CMYK setup. Thisis why some legacy greyscale documents might not look quite the
same as they did in Photoshop 5.x

Spot - Working Space

The Spot pop-up menu is broadly similar to the greyscale, but for spot colours. The options
that we find include a series of five pre-set "dot gain" options and the facility for customising
the "dot gain" curveif required. In my case | simply selected the standard 20% option.

Colour Management Policies

Colour Management Policies is a new phrase introduced by Adobe with Photoshop 6. The
screen-grab below shows atypical setup, but this hides alot of important information.

This topic is probably the one that will cause most new Photoshop users the greatest
difficulty and for that reason the explanation that | give below will appear quite wordy, but
don't be put off. Don't be fooled by the fact that some of the choices have a direct equivalent
in Photoshop 5.x, others bear no relation, and for that, reason each needs to be viewed
carefully.

The area zoned in blue in the above screen grab is VERY important and | highly recommend
that you make the same choices for Profile Mismatch and Missing Profiles as has been shown
above. | usually refer to these particular selections as my "safety net”, you'll see why shortly.

Basically each Working Space will have the same set of three options, although we need not
configure each identically. These options are called Policies and include: -
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(a) Off

In really simple terms, the "Off" Policy ensures that Photoshop does as little as possible when
dealing with profiles. In most circumstances, it really isn't agood choice and certainly not the
choice to be made by new users. The following will give you some idea as to the default
behaviour when this choice of policy is made.

Choosing "Off" will ensure that NEW images/documents will (by default) be saved without
an embedded profile.

Opening an existing image that has an embedded profile that does not match the current
Working Space (profile mismatch) will cause that embedded profile to be stripped out of the
file. The image will subsequently be saved with no embedded profile. The following dialog
will appear if Ask When Opening has not been activated for Profile Mismatches. The
problem with this configuration as compared to the one | recommended in the "Blue Zone"
above is that the user either accepts what Photoshop dictates or doesn't open the image at all,
not much of a choice. To me this choice is akin to the novice high wire artist operating
without a"safety net", stay on the wire or fall off and break your neck!

On opening an image with an embedded profile that matches the current Working Space, it
will be retained and subsequently saved with the image.

The default Pasting behaviour between images is to retain numerical values (the RGB pixel
values), not the appearance. This means that no conversion between colour spaces will take
place.

(b) Preserve Embedded Profiles

For most situations this is my preferred choice of color management policy since it offers the
greatest degree of flexibility, assuming the "safety net" mentioned above is in place. The
following should give you an idea as to the default behaviour of Photoshop 6 when this
choice of policy is made.

Choosing "Preserve Embedded Profiles” will ensure that when an image is opened or
imported into Photoshop and is found to have an embedded profile that differs from the
current Photoshop Working Space, then that image and its associated profile will be left
intact, unless the user decides otherwise. By default, Photoshop will make no attempt to
convert the image to the current Working space; the original embedded profile will be
retained and subsequently saved with the image. Nevertheless, although the image and

Page No 13 of 29



Photoshop are no longer in sync, colour space wise, it is the case that the image preview is
accurate.

The following dialog will appear if Ask When Opening has not been activated for Profile
Mismatches. Again, my comment about Photoshop imposing its will on proceedings applies.

When the image and the Working Space are matched then Photoshop will take no action; the
image is opened and saved as normal.

The default behaviour when Pasting either an RGB or Greyscale image is slightly more
complex; whereby the appearance of the pasted image will be preserved but the numbers will
change values (the pixel values).

In the case of CMYK it isthe numbers that will be retained, not the appearance.

If the image being opened or imported has no embedded profile then Photoshop will use the
current Working Space for editing previewing purposes, and will embed the Working Space
profile when the image is subsequently saved.

Creating a new document with this policy setting will mean that the current Working Spaceis
used for editing, previewing and the associated profile will eventually be embedded into the
file when saved.

(c) Convert to Working Space

This policy behaves in an almost identical fashion to Photoshop 5. It's for this reason that
many tend to favour it and in reality, it isn't a bad choice.

By default, if an image with no embedded profile is opened into Photoshop then the current
Working Space will be used for editing and previewing, however, upon saving the image no
profile will be embedded.

If an image is opened or imported and has an embedded profile which is found to differ from
the current Working Space then that image will be converted into, and subsequently saved in
the Working Space.

When the image and the Working Space are matched then Photoshop takes no action; the

image is opened and saved as normal. Newly created images will be edited, previewed and
ultimately saved in the current Working Space.

Page No 14 of 29



Finally, the default pasting behaviour is to convert and thus preserve the appearance of the
image. However, the user will get the option not to convert the pasted image, hence
preserving the numbersiif the pasted image doesn't match with the target image.

Overriding the Default Policy Behaviour

The previous section described how our choice of Colour Management Policy determined the
default behaviour of Photoshop 6 under various scenarios. However, we need not be confined
to these pre-set outcomes. At the beginning of the previous section | recommended that each
of the "checkboxes' for Profile Mismatches and Missing Profiles be set for Ask When
Opening or Ask When Pasting as appropriate. It is only through setting these checkboxes to
"ON" that we can enable the default behaviour override facility. Furthermore, it is only by
setting these checkboxesto "ON" that we can activate the "safety net".

Basically the three checkboxes have the following impact on the Colour Management
Policies.

(i) Profile Mismatches: Ask When Opening

Photoshop has been set to present the user with a dialog box when the image being opened or
imported (via a scanner) has an embedded profile that does NOT match the current Working
Space. The dialog box looks like the following and contains three options; the pre-set
selection is dependent upon the Colour Management Policy in operation at the time. Noticed
that all the necessary information required to make an informed decision is present.

The above example is pre-set for how the dialog would appear when the Colour Management
Policy is set for Convert to Working Space. The user may now choose to alow the
conversion, leave the image as it is or strip out the embedded profile and switch off colour
management. Had the policy been Preserve Embedded Profile the dialog would have looked
almost identical except that it would have been pre-set for "Use the embedded profile (instead
of the Working Space)".

| think you will agree that the above dialog is lot more user friendly than the one that
appeared under similar circumstances when Ask When Opening was "unchecked".
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(ii) Missing Profiles: Ask When Opening

Photoshop has been set to present the user with a dialog box when the image being opened
has no embedded profile. The dialog box looks like the following and again contains three
options; the pre-set selection is dependent upon the Colour Management Policy in operation
at thetime.

The above example is pre-set for how the dialog would appear when the Colour Management
Policy is set for Preserve Embedded Profile. Since no profile is embedded Photoshop will try
to assign the Working Space profile to the image. No conversion takes place, just the
assignment of the Working Space profile.

The lower Assign Profile and the associated "and then convert to working RGB" checkbox is
the best choice if you know the source images' true colour space and you want the image to
appear in Photoshop. Typically, this option will be used for images from a digital camera or
other similar device, which does not embed a profile into the image file. Note that the source
profile MUST be known and available to the user before this option can be selected.

(ii1) Profile Mismatches: Ask When Opening

The screen grab below shows the "Paste Profile Mismatch" dialog that will appear in the
event of the color spaces of the two images not matching.

Note that the terms preserve "color appearance” and "color numbers' relate to the source
image, not the destination.

The various dialogs that have been shown above are only a sample of those that may appear
as you open or import images that contravene the defined Colour Management Policy.
However, | think that the text messages included in each should be more than ample to
explain what each option does and will therefore allow you to make the appropriate choice.
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Conversion Options

This section will only be present in the Color Settings dialog if the user chooses to activate
the Advanced "checkbox". The screen grab below shows this section of the Color Settings
dialog in its default configuration.

Engine: thisis the name of the engine, which will be used for all colour space conversions.
Unless you have good reason to choose an alternative your should leave it at the default
Adobe ACE setting. ACE is the direct equivalent of the Built-in engine used in Photoshop 5.
Windows users should NOT be tempted to choose ICM. Mac users should keep in mind that
the option chosen here will override the selection made in the ColorSync setup.

Intent: this pop-up menu allows the user to select from four different rendering intents used
during colour space conversions, namely Perceptual, Saturation, Relative Colorimetric and
Absolute Colorimetric. Typically, most users will choose between either the default Relative
Colorimetric or Perceptual. A short description on each is provided in the Description section
of the Color Settings dialog. A more comprehensive explanation can be found in the on-line
help files.

As | understand things, with Relative Colorimetric it is only those source colours that are out
of gamut (i.e. can't be viewed/printed accurately within the destination colour space) that will
be mapped to the closest in-gamut colour, the remainder are left unchanged. This means that
the visual relationship between the colours will almost certainly change. With Perceptual, all
colours of the source colour space will be mapped to the nearest in-gamut colour of the
destination colour space thus maintaining the visual relationship between colours. In other
words, the whole image colour gamut will be compressed so that it fits within the new colour
space.

Use Black Point Compensation: this should be kept "checked". Black Point Compensation
ensures that the darkest neutrals of the source colour space are mapped to the darkest neutrals
of the destination colour space. Also, note that the issue of muddy blacks that used to occur
with Photoshop 5 appears to have been resolved.

Use Dither (8-bit/channel images): as with Black Point Compensation this should be kept

"checked". The description box at the bottom of the Color Settings dialog box will give you
some clue as to what it does.
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Advanced Controls

As with the Conversion Options, this section will only be present in the Color Settings dialog
if the user chooses to activate the Advanced "checkbox". The screen grab below shows this
section of the Color Settings dialog in its default configuration.

An explanation on what each of these options do is provided in the Description box and on-
line help files. The consensus at present appears to be that both settings should be left in the
default "off" condition.

The Desaturate Monitor Color option is the one that has greatest potential to cause confusion
as it will cause the image on screen to become progressively less saturated as the percentage
isincreased. Those choosing to work in VERY wide colour spaces may find it useful, for the
rest leaveit off.

Finally, Remember to select the Save button and give your settings a name and description by
which you can call them back in the future, if for some reason you make a temporary change.

Also, note that you can have as many different sets of settings as you wish, although only one
can be active at atime.

The screen grab below shows my own Color Settings configuration. Notice that | have
chosen Off for my Greyscale Policy and use a customised dot gain for the greyscale Working

Space. You shouldn't try to repeat these settings since they are specific to my Piezography
BW workflow.

Customised Color Settings Configuration
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Part 3 - Soft Proofing and Printing

The most frequently asked question that | receive is "why don't my prints match the screen?”
Generdly it's down to poor monitor calibration, but on other occasions it's down to the fact
that the user has unredlistically high expectations of what can be printed or worse, they have
made the wrong selection in the Photoshop Print dialog.

This section will discuss the new features and commands introduced with Photoshop 6 that
should go some way to answering the above question.

Soft Proofing

There will be many colours that simply cannot be printed accurately on an inkjet; the secret is
to figure out before hand what they are. With Photoshop 5 there wasn't any simple way to
preview on-screen how an RGB image would print to an inkjet printer, although a few
workarounds have been published. Photoshop 6 has addressed this issue with the new Proof
Setup and Proof Colors commands.

Basically soft proofing is nothing more than using your monitor as a proofing device,
however, accurate proofing is dependent upon the quality of the monitor profile created as
described in Part 1 and a profile for the printer. Note that when | write of printer profiles |
mean those for specific media.

In order that we may get Photoshop in a state ready for soft proofing, we must set it up. This
isdone viathe View > Proof Setup menu as shown below.

Although Proof Setup will only affect the current or "active" image on your desktop, you
must configure the proof setup via the Custom menu option with NO image/document open.
If you attempt to configure Proof Setup with an image/document open then the existing
Photoshop "default”, Soft Proof Profile will be retained.

Before explaining how to configure Proof Setup, | hope you also notice the three RGB

options towards the middle of the drop-down menu. You can actually use these to preview
how your image will look on other platforms, e.g. Mac or PC and on your own computer
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outside of Photoshop using the Monitor RGB option. The Monitor RGB option is effectively
the same as switching off the "Display Using Monitor Compensation” checkbox of
Photoshop 5. Assuming that you are NOT using a VERY wide working space e.g. EktaSpace
or Adobes Wide Gamut RGB the Monitor RGB option also provides a method of checking
the quality of your monitor profile. If on selecting Monitor RGB, the image turns very ugly
you can take it as read that the monitor profile is messed up. By ugly | mean significantly
different, large colour shifts, not just a bit brighter, darker or flatter (e.g., whites turn yellow).

The screen grab below shows a typical view of the Proof Setup dialog for printer output
simulation. From this dialog you can easily select, configure and save your own customised
soft proofing setup for any number of different printer profiles. Remember make sure you
have NO images or documents open when going through this process.

We begin the process by choosing the Profile, in the example shown above | have selected
the Epson profile for Photo Paper. This choice will be the profile for the media that you want
to simulate on the monitor

Preserve Color Numbers

This option will only be available if the image and printer profiles are in sync, i.e. both are
RGB or both are CMYK. Selecting the Preserve Color Numbers checkbox will usualy result
in aquite awful looking display, thisis how it should be.

One purpose of this option is to enable you to see how the image would print if the media
profile had not been selected in the Profile pop-up menu. There are apparently others, but
these al well beyond my understanding. Normally it is best the leave the checkbox
unchecked.

Intent

| described Intent previously when discussing the Conversion Engines. Typicaly, it will be
best to stick with Perceptual when dealing with photographic type images.

Simulate

There are two options (or checkboxes) shown in this section of the Proof Setup dialog. In
theory, the first Paper White allows you to simulate the colour of the paper white. The second
Ink Black will enable you to ssimulate how dark black will appear on the media you are
printing. Note that selecting the Paper White checkbox will cause the Ink Black to be selected
and greyed out. The resulting soft proof display can be quite disconcerting in that the overall
tone of the image may tend to look compressed/flat or slightly colour shifted. This may
especialy be the case when attempting to use scanner based profiles to soft proof the Epson
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870/1270/2000 series printers. In such circumstances, it is best to ignore the use of the "Paper
White" and "Ink Black" since it is VERY unlikely that they are in fact providing an accurate
soft proof.

When describing the Simulation facility | wrote "in theory" this is because NOT all profiles
are created equally and some simply do not contain the information to allow the simulation to
work. At time of writing, the consensus is that selecting Paper White or Ink Black is probably
not going to provide you with an accurate preview, so for now leave both unchecked.

Printing to an Epson Inkjet

At first the new Print dialog in Photoshop 6 will appear a bit more complex than its
predecessor. It contains a few new options and has (on the surface at least) omitted an option

that caused considerable confusion in Photoshop 5, namely the Printer Color Management
checkbox.

When Print is selected from the File menu a dialog similar to that shown below should
appear. You should check to see the image Source Space and the Print Space: Profile. You
will NOT be able to change the Source Space, nor do you really want too. The Source Space
tells us which one of the Photoshop Working Spaces the image is actually in. If you were to
leave the Print Space Profile as Same as Source then the resulting print is likely to be less
than optimal. This is because all you have done is told the printer to print EXACTLY what is
shown on the monitor, without any allowance for the drivers preferred colour space.

The following examples show how to configure the Print dialog and driver if using an Epson
printer. The first two that | show the are for Mac OS, the final two are for PC Windows.

Example 1 - Epson Recommended Automatic Settings (Mac OS)

The image should be in a Photoshop Working Space such as ColorMatch, Adobe RGB
(1998), BruceRGB, etc.

Photoshop 6 Print Dialog Configuration - Method 1
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* Choose the mediatype (I show Photo Paper).

» Select Print Space: Profile Pop-up menu and choose "Printer Color Management”.
This ensures that the correct profile for the image is embedded into the image file and
that the printer will carry out the correct colour space conversions, do NOT leave the
Profile set at "Same as Source”.

* Choose Custom Mode.

» Select Advanced, the following dialog appears.

* In Color Management, choose either of the options Color Controls, PhotoEnhanced or
ColorSync.

» Select your preferred Print Quality setting.

Epson Advanced Settings Dialog (Mac OS) - Epson Profile
Example 2 - Using ColorSync Media Profiles (Mac OS)

Again, the image should be in a Photoshop Working Space such as ColorMatch, Adobe RGB
(1998), BruceRGB, etc.

Photoshop 6 Print Dialog Configuration - Method 2

Page No 22 of 29



* Choose the mediatype (I show Photo Paper).

» Select Print Space: Profile Pop-up menu and choose an "ColorSync media profile".
These will be supplied by Epson (only supplied with Mac drivers), created by
yourself or professionally.

Select Perceptua as the Intent.

Choose Custom Mode.

Select Advanced, the following dialog appears.

In Color Management, choose "No Color Adjustment”.

Select your preferred Print Quality setting.

Epson Advanced Settings Dialog (Mac OS) - Custom Profiles
Example 3 - Epson Recommended Automatic Settings (PC Windows)

Again, the image should be in a Photoshop Working Space such as ColorMatch, Adobe RGB
(1998), BruceRGB, etc.

Photoshop 6 Print Dialog Configuration - Method 1
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» Ensure that the "Document” radio button is selected.

e Select Print Space: Profile Pop-up menu and choose "Printer Color Management”.
This ensures that the correct profile for the image is embedded into the image file and
that the printer will carry out the correct colour space conversions.

» Select "Setup”, shown with blue boundary.

* When Page Setup Diaog appears select "Properties’, the following dialog appears.

» Select Custom followed by Advanced, the following dialog appears.

Epson Advanced Settings Dialog (Windows Driver)

* In Color Management, choose either of the options Color Controls, PhotoEnhanced,
SRGB or ICC.

* Choose the mediatype (I show Photo Paper).

» Select your preferred Print Quality and Halftoning settings.
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Example 4 - Using ICC Media Profiles (PC Windows)

Again, the image should be in a Photoshop Working Space such as ColorMatch, Adobe RGB
(1998), BruceRGB, etc.

Photoshop 6 Print Dialog Configuration - Method 2

» Ensure that the "Document” radio button is selected.
» Select Print Space: Profile Pop-up menu and choose an "ICC media profile". These

will be created either by you or professionally.
» Select Perceptual asthe Intent.
» Select "Setup”, blue boundary.
* When Page Setup Diaog appears select "Properties’, the following dialog appears.
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*  Choose the mediatype (I show Photo Paper).
» Select Custom followed by Advanced, the following dialog appears.

* In Color Management, choose "No Color Adjustment”.
» Select your preferred Print Quality and Halftoning settings.

Part 4 - What else is New and Improved?

An interesting question! On the Colour Space conversion and profile embedding front we
find that Profile to Profile command of Photoshop 5 is no more, some say thankfully; others
are still wiping away the tears. Not to worry, Adobe has provided us with a new and more
effective command that is broadly similar in operation, namely, Convert to Profile. They
have also added a new command - Assign Profile. This command allows the user to assign
any profile to an image without actually converting the image.

Finally, the Save As dialog has also undergone a few significant changes with new features
being included; I'll also discuss these.

Assign Profile

The Assign Profile command is accessed via the Image > Mode menu and allows the user to
assign any profile of their choosing to an image. The command itself was designed for only
few limited uses, typically with images that have been scanned into Photoshop using a Twain
module or a scanner package that has no means of embedding an ICC/ColorSync profile.

Assuming the Colour Management Policy is not OFF, then an image scanned into Photoshop

with NO embedded profile will be "assigned”, "previewed" and subsequently "saved" in the
current Photoshop Working Space. Obviously, this may not be the most appropriate colour

Page No 26 of 29



gpace in which to edit or save the image, so assuming the user has the correct source profile
we can make the necessary assignment.

It is important to note that unlike the Profile to Profile command of Photoshop 5, assigning a
profile will NOT convert the image (will not change the numbers; i.e. RGB pixel values). It
simply tells Photoshop the actual colour space that you wish to edit and view the image in (it
changes the image appearance or meaning of the numbers).

Other potential uses for Assign Profile include the removal of an embedded profile (don't
colour manage the image) and assign a correction profile to an image that the user knows has
been embedded with an incorrect profile (define a new source profile).

Convert to Profile

The Convert to Profile command found under the Image > Mode menu is an enhanced
version of Profile to Profile. With Profile to Profile we were able to define the source colour
space (and probably get it wrong), in Photoshop 6 this cannot be done since the assigned
profile for the imageislocked. The only way that this source profile can be changed is viathe
Assign Profile command discussed above.

In the example above | show an image with an embedded profile (Source Space = Adobe
RGB) being converted into an image that will be in ColorMatch (Destination Space).
Whenever we make this conversion, it will be the profile for the destination space that is
embedded within the image file when saved. Convert to Profile changes the numbers (i.e.
pixel values) appearance is maintained.

The inclusion of the Preview checkbox allows the user to compare the conversion with and
without Black Point Compensation, Dithering and any one of the four rendering Intents. The
ability to preview the conversion is a real boon and shouldn't be ignored, use it to your
benefit.
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Actually, some users prefer to use this command to prepare their images for printing, much as
they did with "Profile-to-Profile" in Photoshop 5. The advantage of this approach is that it
provides a very accurate preview of how the image will print, and gives the user the ability to
use (and preview) the aternative conversion options.

If you do choose this approach for printing then simply select "Same as Source" (direct
equivalent of RGB in Photoshop 5) as the Print Space, the reminder of the settings are as
described previously. However, the printer driver must be set for "No Color Adjustment”
mode.

Photoshop Print dialog settings required for this method of printing

Also, notice that that whereas in the previous examples the "Document Space" was the same
as the Photoshop Working Space it is now the name of the media profile you selected in
Convert to profile.

Save As

Last but not least, the new Save As dialog throws up a host of new and useful features. Most
of the new features are not really new at all; just their location has changed.

The Embed Profile checkbox previously existed in the Photoshop Profile Setup dialog. The
chief difference being that whereas it impacted on each and every file being saved, the new
option in the Save As dialog is specific to the image being saved. You can keep it ON or turn
it OFF as you please. The latter option being a bad idea in most instances. Notice that the
dialog even informs us which profile is being embedded.

The screen grab shown below is how the dialog appears on Mac OS systems; the PC version
will look slightly different, but is functionally identical.
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Save As- Mac Version

The other save options present in the dialog are those associated with Layers, Alpha
Channels, Annotations, etc. Again, we can choose to uncheck them and so save the image
without the layers, etc. The Save As a Copy feature is engaged by default as soon as you
uncheck Layers, this prevents you trashing alot of hard work.

Conclusions

| wrote at the outset of this article that Photoshop 6 had many new and powerful features,
some of which had effectively been ignored by various magazine commentators. The vastly
improved colour management system was one such feature, which is a great pity because on
its own it justifies the price of the upgrade. However, being fair to the commentators Adobe
didn't exactly go out their way to beat a drum telling the world of these improvements, worse
they haven't really managed to document the new setup in a clear unambiguous manner.

| hope that this article will have provided you with some insight as to how Photoshop 6
should be configured. Obviously each user will have hisher own preferences, but the
principles are the same for all. As good management will tend to make for a more productive
work environment, a good colour-managed workflow will make for a more productive
experience in Photoshop. So now that we have Photoshop 6 configured we can get on with
the business of creating and editing our images in the knowledge that things should appear in
print as we see them on the monitor.
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